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COPYRIGHT 

 
Copyright 2003 (c) by Polar Instruments Ltd. All rights reserved. 
This software and accompanying documentation is the property of 
Polar Instruments Ltd and is licensed to the end user by Polar 
Instruments Ltd or its authorized agents. The use, copying, and 
distribution of this software is restricted by the terms of the license 
agreement. 
 
Due care was exercised in the preparation of this document and 
accompanying software. Polar Instruments Ltd. shall not be liable 
for errors contained herein or for incidental or consequential 
damages in connection with furnishing, performance, or use of 
this material. 
 
Polar Instruments Ltd makes no warranties, either expressed or 
implied, with respect to the software described in this manual, its 
quality, performance, merchantability, or fitness for any particular 
purpose. 

DISCLAIMER 
 
1. Disclaimer of Warranties 

POLAR MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED OR 
STATUTORY, REGARDING PRODUCTS. ALL OTHER WARRANTIES 
AS TO THE QUALITY, CONDITION, MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT ARE 
EXPRESSLY DISCLAIMED. 

2. Limitation of Liability. 

POLAR SHALL NOT BE RESPONSIBLE FOR DIRECT DAMAGES IN 
EXCESS OF THE PURCHASE PRICE PAID BY THE END USER OR 
FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE 
DAMAGE, INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS 
OR DAMAGES TO BUSINESS OR BUSINESS RELATIONS, 
WHETHER OR NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF 
SUCH DAMAGES, THE FOREGOING LIMITATIONS SHALL APPLY, 
NOTWITHSTANDING THE FAILURE OF ANY EXCLUSIVE REMEDIES. 
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TRADEMARKS 
 
Copyright Polar Instruments Ltd. ©2003 
 
Microsoft, Windows, Windows 95, Windows 98, Windows NT, 
Windows 2000 and Excel are registered trademarks of Microsoft 
Corporation. 
 
IBM is the registered trademark of International Business 
Machines Corporation. 
 
All other trademarks acknowledged. 
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Personal Computer Requirements 

Computer IBM PC AT or compatible 

Processor Pentium 500 (1GHz or better recommended) 

Operating system Microsoft Windows 95, Windows 98 
Microsoft Windows NT, Windows 2000/XP 

System memory 
required 

128MB recommended 

Hard disk space 
required 

100MB (min.) 

Video standard SVGA (1024 x 768 min.) 

CDROM drive  

Mouse Microsoft compatible 

Software key port Parallel port/USB port 

Spreadsheet Microsoft Excel 2000 or later 
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Guide To The Manual 

Introduction Introduces the Polar Instruments Si8000. 

Introduction to 
controlled 
impedance PCBs 

Brief discussion of the requirement for 
controlled impedance, impedance matching 
and calculation methods. 

Transmission line 
structures 

Brief discussion of the PCB structures used 
for controlled impedance. 

Installation/set up Hardware and software requirements and 
instructions for installing and uninstalling the 
software. 

Using the Si8000 
Quick Solver 

Using the Si8000 Quick Solver for single 
impedance, propagation delay, inductance 
and capacitance calculations. 

Using the Si8000 
functions 

Learning the Si8000 functions using the 
supplied sample Si8000 workbook. Using the 
Si8000 functions in your own applications in 
Si8000 expert mode. 
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Introduction to the Si8000 

The Si8000 Controlled Impedance Field Solver 
The Polar Si8000 Controlled Impedance Field 
Solver uses advanced field solving methods to 
calculate PCB trace impedance for most single-
ended and differential circuit designs. Based on 
boundary element analysis, the Field Solver is 
able to provide rapid modelling for a wide range 
of microstrip, stripline and coplanar structures. 

Multiple dielectric builds 
The Si8000 features advanced modelling to 
predict the finished impedance of multiple 
dielectric PCB builds and also takes into account  
the local variations in dielectric constant on close 
spaced differential structures (e.g. areas of high 
resin concentration between differential pairs). 

Surface coating modelling 
The Si8000 models the resist thickness adjacent 
to, above and between surface traces. This offers 
an elegant solution to modelling surface coating 
which can be tailored to the particular resist 
application method in use. The new Si8000 also 
extracts even and common mode impedance. It is 
becoming increasingly necessary to control these 
characteristics on high speed systems such as 
USB2.0 and LVDS.  

The Si8000 comprises the Quick Solver for single 
impedance and parameter calculations and a 
comprehensive set of advanced field solving 
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methods incorporated as user-defined functions in 
the popular Microsoft Excel spreadsheet format. 

Si8000 Quick Solver 
The Quick Solver provides for rapid calculation of 
single PCB trace impedance values against 
significant PCB parameters (e.g. trace height and 
thickness, dielectric constant, etc.) Given a target 
impedance the Si8000 allows the user to 
calculate circuit parameter values to achieve the 
desired impedance. For situations with structure 
dimensional constraints, the Field Solver 
Tolerance fields allow the designer and board 
fabricator easily to calculate the effects of 
variations in supplier material dimensions. 

Si8000 spreadsheet functions 
The Si8000 functions included in Excel format 
enable advanced functions, e.g. sensitivity 
analysis, graphing the effects of a range of 
parameter value changes. The Si8000 supports 
single or multiple dielectric builds in a 
comprehensive range of trace and dielectric 
configurations. The Si8000 provides models for 
structures with dielectric layers above and below 
traces, soldermask modelling and includes 
compensation for resin rich areas between traces. 

Evaluating PCB structure behaviour 
The Polar Si8000 runs within the Microsoft 
Windows environment. The Field Solver uses the 
familiar Microsoft Excel for Windows interface for 
easy graphing and data sharing. Using Excel’s 
powerful Autofill and Chart Wizard features, the 
Si8000 can rapidly chart Z0 against a varying 
parameter, providing easy comparison and 
evaluation of the behaviour of most popular 
controlled impedance structures. 
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Introduction to Controlled Impedance 
PCBs 

Controlled impedance 
The increase in processor clock speed and 
component switching speed on modern PCBs 
means that the interconnecting paths between 
components (i.e. PCB tracks) can no longer be 
regarded as simple conductors. 

At fast switching speeds or high frequencies (i.e. 
for digital edge speeds faster than 1ns or analog 
frequencies greater than 300MHz) PCB tracks 
must be treated as transmission lines; i.e. for 
stable and predictable high speed operation the 
electrical characteristics of PCB traces and the 
dielectric of the PCB must be controlled. 

One critical parameter is the characteristic 
impedance of the PCB track (the ratio of voltage 
to current of a wave moving down the signal 
transmission line); this will be a function of the 
physical dimensions of the track (e.g. track width 
and thickness) and the dielectric constant of the 
PCB substrate material and dielectric thickness. 
The impedance of a PCB track will be determined 
by its inductive and capacitive reactance, 
resistance and conductance. PCB impedances 
will typically range from 25Ω to 120Ω. 

In practice a PCB transmission line typically 
consists of a line conductor trace, one or more 
reference planes and a dielectric material. The 
transmission line, i.e. the trace and planes, form 
the controlled impedance. 
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The PCB will frequently be multi-layer in 
fabrication and the controlled impedance can be 
constructed in several ways. However, whichever 
method is used the value of the impedance will be 
determined by its physical construction and 
electrical characteristics of the dielectric material: 

The width and thickness of the signal trace 

The height of the core or pre-preg material 
either side of the trace 

The configuration of trace and planes 

The dielectric constant of the core and pre-
preg material 

Impedance matching 
Components themselves exhibit characteristic 
impedance so the impedance of the PCB tracks 
must be chosen to match the characteristic 
impedance of the logic family in use. 

If the impedance of the PCB tracks does not 
match the device characteristic impedance 
multiple reflections will occur on the line before 
the device can settle. This can result in increased 
switching times or random errors in high-speed 
digital systems. The value and tolerance of 
impedance will be specified by the circuit design 
engineer and the PCB designer, however, it will 
be left to the PCB manufacturer to conform to the 
designer's specification and verify the finished 
boards meet the specification. 

Calculation methods 
The Si8000 incorporates field solving for single-
ended and differential impedance structures. The 
discrete numerical analysis in the Si8000 uses 
the Boundary Element Method to evaluate the 
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residual field. A piecewise linear approximation is 
used with a weighted sub-division of the 
perimeter of the trace cross-section to predict the 
surface charge distribution on the trace. Knowing 
the boundary voltage conditions and the charge 
distribution allows the Boundary Element Method  
to predict the capacitance of the structure. This in 
turn allows the impedance of the structure to be 
calculated. 
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Transmission Line Structures 

Microstrip and Stripline Transmission Lines 
Controlled impedance PCBs are usually produced 
using microstrip and/or stripline transmission lines 
in single-ended (unbalanced) or differential 
(balanced) configurations.  

A micro strip line consists of controlled width 
conductive traces on a low-loss dielectric (in 
practice the dielectric may be constructed from a 
single dielectric or multiple dielectric layers) 
mounted on a conducting ground plane. The 
dielectric is usually made of glass-reinforced 
epoxy such as FR-4. For very high frequencies 
PTFE may be used. Other reinforcement/resin 
systems are also available. 

For close spaced differences on woven glass 
reinforced dielectrics, refer to application note 
AP139 on the Polar Instruments web site, 
www.polarinstruments.com 

There are several configurations of PCB 
transmission line: 

Exposed, or surface, microstrip 

Coated microstrip (coating usually solder 
mask) 

Buried, or embedded, microstrip 

Centred stripline 

Dual (offset) stripline 

Coplanar strips and waveguides 

The structures above can be constructed with 
single or multiple dielectrics. 



Single-ended Transmission Lines 
Single-ended transmission lines are the 
commonest way to connect two devices (i.e. a 
single conductor connects the source of a device 
to the load of another device). The reference 
(ground) plane provides the return path. 

Note that in the diagrams the trace is trapezoidal 
in profile and width, W, refers to the trace width 
nearest the upper surface, W1 refers to the trace 
width nearest the lower surface. 

Surface Microstrip 

In the diagram below (surface, or exposed, 
microstrip) the signal line is exposed (to air) and 
referenced to a power or ground plane. In the 
Si8000 structures are categorised according to 
the arrangement of the dielectric with respect to 
the trace (below or above the trace). The diagram 
below shows the surface microstrip structure 
using a single dielectric layer below the signal 
trace (designated 1B) 

 

Surface microstrip with single dielectric below the trace 
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The diagram below shows the surface microstrip 
structure using two dielectric layers below the 
trace (designated 2B). 

 

Surface microstrip with two dielectric layers below the 
trace 

Embedded Microstrip 

Embedded, or buried, microstrip is similar to the 
surface version, however the signal line is 
embedded between two dielectrics and located a 
known distance from the reference plane. 

 

 

Embedded microstrip with two dielectric layers, one 
below and one above the trace 
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In this structure the two dielectrics are arranged 
one below and one above the trace (designated 
1B1A). Embedding the signal line can lower the 
impedance by as much as 20% compared to an 
equivalent surface microstrip construction. 

Coated Microstrip 

 

Coated microstrip with single dielectric below the trace 

Coated microstrip is similar to the surface version, 
however the signal line is covered by a solder 
mask. This coating can lower the impedance by 
up to a few ohms depending on the type and 
thickness of the solder mask. 

 

Coated microstrip with two dielectrics below the trace 
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Offset Stripline 

 
In this configuration the signal trace is 
sandwiched between two planes and may or may 
not be equally spaced between the two planes. 
This construction is often referred to as Dual 
Stripline. 

A second mirror trace will be positioned H1 from 
the top ground plane. These two signal layers will 
be routed orthogonally (crossing at right angles 
so as to minimise the crossing area). 

Differential Transmission Lines 
The differential configuration (often referred to as 
a balanced line) is used when better noise 
immunity and improved timing are required. In 
differential mode the signal and its logical 
complement are applied to the load.  

The balanced line thus has two signal conductors 
and an associated reference plane or planes as in 
the equivalent single-ended (unbalanced) case. 
Fields generated in the balanced line will tend to 
cancel each other, so EMI and RFI will be lower 
than with the unbalanced line. External noise will 
be "common-moded out" as it will be equally 
sensed by both signal lines. 
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Note that in the following diagrams (except the 
Broadside-coupled Stripline) the traces are 
trapezoidal in profile and width, W, refers to the 
trace width nearest the upper surface, W1 refers 
to the trace width nearest the lower surface. 

Edge-coupled Surface Microstrip 

 

Edge-coupled surface microstrip with single dielectric 
below the trace 

In this construction the gap between the traces, 
S1, defines the coupling factor and hence the 
differential impedance. The etch factor, plating 
density and undercut will make this construction 
simple to manufacture, but with a wider tolerance 
due to the extra processing required on external 
layers. 
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Edge-coupled Coated Microstrip 

 

Edge-coupled coated microstrip with single dielectric 
below the trace 

As in the case of the Surface Microstrip this 
construction is simple to fabricate, but the extra 
process of adding solder mask coating can cause 
impedance variations. The Si8000 enables the 
operator to specify the thickness of the coating 
outside, above and between the traces to allow 
for variations in the board fabricating process. 

This construction is particularly sensitive to solder 
mask flooding with LPI (Liquid Photo Imagable) 
solder mask. This causes the dielectric constant 
in the edge coupling region to vary, depending on 
flood depth. 
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Edge-coupled Embedded Microstrip 

 
Edge-coupled embedded microstrip with one dielectric 

below and one above the traces 

The reduced processing of internal layers makes 
the Edge-coupled Embedded Microstrip 
construction easy to fabricate with more 
consistent results than the equivalent surface 
trace structure. During the manufacturing process 
resin will be forced in between the traces resulting 
in a resin-rich region (shown as Rer in the 
1B1A1R model below) between the two traces. 
This region will result in a dielectric with Er 
different from the rest of the structure. 

 
Edge-coupled embedded microstrip with resin-rich 

region between the traces 
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Edge-coupled Offset Stripline 

 
Edge-coupled offset stripline with one dielectric below 

and one above the traces 

As in the case of the single-ended Offset Stripline 
construction this structure can be made up as a 
dual construction with a mirrored edge-coupled 
differential pair set a distance H1 from the upper 
reference plane. The lower pair is routed 
orthogonal to the upper to minimise layer to layer 
coupling and cross-talk. The model below shows 
a structure with two layers below the traces and 
one above and includes the resin rich region 
between the traces 

 
Edge-coupled offset stripline structure modelling the 

resin-rich region between the traces 
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Broadside-coupled Stripline 

 
Broadside-coupled offset stripline with two substrate 

dielectrics, H1 and H2 

This apparently simple construction is actually 
one of the most difficult to fabricate to produce 
consistent impedance results. 

Despite having internal layers with minimal 
processing, the most common structure is that 
with both traces overlaid for maximum coupling.  

Inner-layer mis-registration and slight offsets and 
differences in etching combine to make this more 
difficult to achieve consistent results, particularly if 
the traces are fine-line. 

 
Broadside-coupled offset stripline with three substrate 

dielectrics, H1, H2 and H3 
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The Si8000 broadside-coupled model assumes 
symmetry of dielectric in the two H2 and H3 
layers — the two layers will normally be 
fabricated from the same material, i.e. with the 
same dielectric constant. 

Note that in the Broadside-coupled Stripline case 
the traces are trapezoidal in profile and width, W, 
refers to the trace width nearest the surfaces, W1 
refers to the trace width nearest the center. 

Coplanar Lines 
Most Microstrip and Stripline transmission line 
structures can be manufactured in a Coplanar 
version. 

Coplanar structures have the advantage of single-
sided construction with the signal line and ground 
on the same plane. Components can be 
grounded on the same plane as the signal line; 
this means the coplanar configuration is ideally 
suited for surface mounted devices. 

In addition, the coplanar configuration shows only 
minor dispersion effects compared to microstrip 
lines. 

Coplanar Lines incorporate ground conductors 
adjacent to the controlled impedance trace(s) in 
the same plane as the trace(s).  



Surface Coplanar Strips 

 

Surface Coplanar Strips with Ground 

Coplanar Lines may be constructed with or 
without a ground plane underneath the controlled 
impedance trace(s).  

 

This structure is an example of a controlled 
impedance trace on a single sided board that will 
typically be used in consumer applications. 
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Differential Surface Coplanar Strips 

 
The diagram above shows a differential surface 
coplanar structure with strips and a lower ground 
plane fabricated using two dielectric layers 
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Installing the Si8000 Field Solver 

Activating the Si8000 
Note: The structures available will depend on the 
license purchased. It will be necessary to activate 
the product license prior to performing 
calculations with the Si8000. 

The Si8000 is licensed using the FLEXlm License 
Manager or a software key connected to either 
the parallel port (typically LPT1) or a USB port 

The FLEXlm licensing files should be installed 
and running on a locally accessible server. The 
server must be running to manage licensing. 

Licensing the Si8000 using FLEXlm 
When the first calculation is performed the Si8000 
FLEXlm License finder asks for the name of the 
License Server or License File. 

 

Ensure the Specify the license Server option is 
selected and press Next. 
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Enter the name of the License Server and press 
Next. 

 
The name will normally be the Network 
Identification name of the computer acting as the 
Licensing Server. 

The Si8000 will perform calculations within the 
terms of the license purchased. 

Installing the software key 
If a software key is used insert the key into the 
parallel printer port or USB port; if required, plug 
the printer cable into the software key. 

Note: If installing the software key on a Microsoft 
Windows NT or Windows 2000/XP system it will 
be necessary to be logged on as Administrator. 

Uninstalling the software 
To uninstall the Si8000 software click the 
Windows Start button and choose Settings and 
Control Panel. 

Double-click Add/Remove Programs and choose 
Si8000 from the list. Click Remove. 

 

20  •  Si8000 Controlled Impedance Field Solver  



Using the Si8000 Quick Solver 

The Si8000 Quick Solver 
The Si8000 Quick Solver allows the operator to 
perform rapid single calculations of PCB trace 
values against significant PCB parameters. The 
Si8000 Quick Solver solves for impedance, 
propagation delay and inductance and 
capacitance per unit trace length. Click the 
Si8000 Quick Solver icon on the desktop to start 
the Si8000 Quick Solver. 

 
Si8000 Quick Solver – Standard Interface 
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To specify dimensional values click the parameter 
in the diagram or select the associated text box. 

Calculating impedance 
Click on the configuration from the Structures 
menu or from the Structures Bar. Select the 
dimension units (mils, inches, microns or 
millimetres) from the Units option group. Enter the 
parameter values in the associated text boxes. 
For example, the Surface Microstrip structure 
uses: 

H1 (Height) — dielectric thickness 
W1 and W2 (Width) — signal trace width 

(allowing for finished etch factor) 
T1 (Thickness) — signal trace thickness 
Er1 — dielectric constant 

Other structures will use additional parameters; 
press the Impedance Calculate button. The 
calculated impedance will appear in the 
Impedance (Zo) box. 
Add explanatory notes on your particular 
construction, if necessary, in the Notes text box. 

Specifying Goal Seeking convergence 
The convergence values used during goal 
seeking are specified in the Configuration screen 
(see Setting Si8000 parameter limits). Choose 
between fine convergence to derive parameters 
whose values may be infinitely variable (e.g. trace 
width) and coarse convergence for parameters 
whose values may be fixed by supplier (e.g. 
height). 

Typically the user will enter all the known 
parameters and goal seek for the desired 
impedance on the dielectric height. Using the 
coarse convergence option can speed up goal 
seeking on complex structures. The trace width 
can then be derived using fine convergence. 



Calculating propagation delay, inductance 
and capacitance 
Click on the configuration from the Structures 
menu or from the Structures Bar. Enter the 
parameter values as described above into the text 
boxes and press the More… button. 

The Si8000 displays the results of propagation 
delay, inductance and capacitance in the selected 
units. Press Close to exit. 

Quick solving for board parameters 
The Quick Solver can solve for board parameters 
given a nominal impedance value. 

 
Enter the given board dimensions in their 
associated fields and the nominal impedance 
value in the Impedance field and click the 
Calculate button against the unknown dimension, 
e.g. Substrate Height, Width, etc. 

Using the Extended Interface 
Selecting the Extended Interface Style displays 
additional fields, Tolerance, Minimum and 
Maximum allowing the user to specify a range of 
values for each parameter and observe the effect 
of manufacturing process variations. 
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Fields which control the maximum impedance 
value are shown in green, fields which control the 
minimum impedance value are shown in orange. 

In this example we specify a nominal impedance 
value of 80Ω and observe the effects on the 
nominal impedance of a manufacturing variation 
of ±1mil in the substrate height. 

Select the Extended Interface, enter a value of 
80Ω in the Impedance field and click the 
Substrate 1 Height Calculate button 

 
The nominal Substrate 1 Height is calculated at 
9.75 mil. Enter a value of 1mil in the Substrate 1 
Height Tolerance field and click the Impedance 
Calculate button. 
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The Si8000 calculates the range of impedance for 
a 1mil variation in H1 as 76.27–83.40Ω. 

Other parameter tolerances can included as 
necessary. Enter a value of 0.5 in the Substrate 1 
Dielectric Tolerance field and click the Impedance 
Calculate button. The impedance range should 
now show 72.71–87.91Ω. 

 
Setting Si8000 parameter limits 

The Si8000 is designed to work with “real world” 
values. If the parameter values used in 
calculation are beyond the Si8000 limits, the 
Si8000 returns a value of zero. The user is able to 
control the range of values used by the Si8000 
field solving engine during calculation. 

Click the Configure menu; the Si8000 
Configuration dialog is displayed. 
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Enter the values for minimum and maximum for 
each parameter and number of calculation 
iterations (Si8000 Quick Solver Tries). 

Saving and recalling results 
Impedance calculation results for a board type or 
vendor, for example, may be saved to disk and 
recalled for future reference. 

From the File menu choose the Save As… 
command. Choose a name and destination and 
press Save. 

The program will only save calculated results. 
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To recall a set of results choose Open… from the 
File menu and choose the desired results file and 
press Open. 

Printing results 
Choose Print from the File menu to print a hard 
copy of the Si8000 Quick Solver screen. 

Copying Quick Solver parameters to Excel 
Selecting this command from the Edit menu 
takes the current parameters from the Quick 
Solver and places them on the Windows 
clipboard in Microsoft Excel format. 

The parameter values may then be pasted to a 
suitable location in an Si8000 or Si8000Expert 
workbook. The values are placed horizontally 
beginning at the active cell location. The number 
of cells required depends upon the structure 
chosen. Ensure no important data are overwritten 
in the process. 

The operator can now use Excel’s Paste Function 
command to insert the associated Si8000 function 
using the pasted Quick Solver parameter values 
as arguments. 

(See Using the Si8000 Field Solver.) 

Using the Si8000 Field Solver 

Starting the Field Solver 
Note: the graphics displayed in this section are 
based on Microsoft Excel 2000. Dialog box graphics 
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from different versions of Microsoft Excel may 
display slight differences from those shown here. 

The Field Solver functions for each controlled 
impedance structure are built into Microsoft Excel 
workbooks Si8000.xls and Si8000Expert.xls as 
user-defined functions. This allows rapid and 
convenient analysis of board trace characteristics 
such as impedance, propagation delay, inductance 
and capacitance against several varying board 
parameters. 

In addition to the Field Solver functions, the 
Si8000.xls workbook includes pre-built sample 
data worksheets incorporating tables of functions 
and their associated parameters. 

If the Si8000.xls workbook opens with the warning 
that the workbook contains macros (Visual Basic 
code), click the Enable Macros button to allow the 
field solver to perform calculations. (See Excel’s 
Tools|Macro|Security… command and the 
discussion on security levels in Excel’s help file). 

The workbook opens by default as read-only; this 
allows the operator to perform calculations but not 
save changes to the workbook. 

The Si8000Expert.xls sheet includes the Si8000 
functions but does not include the sample 
worksheets. 

Double click the Field Solver icon on the desktop; 
Microsoft Excel opens the Si8000.xls workbook at 
the Si8000 index sheet. 



 
Si8000 index sheet — Single Ended Structures 

Si8000 structure categories 
The index sheet displays the Si8000 structure 
categories; each group of structures contains the 
associated models 

To select a structure, scroll to the category and 
click on its graphic, e.g. Surface Microstrip 1B. 
The Si8000 activates the associated worksheet. 

Each worksheet comprises the graphic 
associated with the chosen model, a table with 
predefined values and an embedded chart that 
uses the table as its data source (typically set to 
chart impedance against substrate height). The 
user can redefine the chart source data to shoe 
results for other columns. 
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Surface Microstrip sample worksheet 

Moving through the structure sheets 
Structure sheets may also be selected via the 
Tab Scrolling Buttons, . 

Click the buttons to select the first, previous, next 
or last structure sheets. 

Alternatively, use the Ctrl + Page Up/Ctrl + Page 
Down keys to move to the previous/next sheet. 

To move directly to a structure, right click the Tab 
Scrolling Buttons to display the list of structure 
sheets. 
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Select the structure from the list. If necessary 
choose More Sheets… to display the complete 
list of structures. 
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Calculating trace characteristics 
Each worksheet includes a pre-built sample 
application, incorporating a table of typical 
dimensions for use with the function associated 
with the structure and a chart displaying the 
change in impedance (Z0), propagation delay (D), 
inductance (L) or capacitance (C) against 
structure dimensions (in the sample chart below 
Z0 is shown against a varying Substrate Height 
(H1) with other parameters fixed). 

 
Sample table with increasing values of H 

The sheet opens with the single value of Z0 
calculated for the structure dimensions shown in 
the first row. The field solving function is located 
in the cell labelled Z0, the parameters for the 
function are contained in the associated cells 
labelled H1, Er1, W1, W2, T1, etc. 

Choosing the calculation type, Z, D, L, C 
To calculate other characteristics for the selected 
parameters, enter the value D, L or C in the 
associated cell in the Calc Type column (labelled 
Calc Type), move to another cell and press the 
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Calculate button. Re-label the results column if 
necessary. Differential structures include other 
characteristics, e.g. Zeven, Zodd, ZCommon. 

To see which characteristics are available for a 
structure, move the mouse over the Calc Type 
label to display the Note text box. 

 
Enter the characteristic type in the Calc Type 
(e.g. Zeven) exactly as shown in the note. 

Charting against varying board parameters 

The Si8000 sheet opens with the value of Z0 
against H for the structure dimensions shown in 
the first row and charted as shown below. 
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To chart the change in Z0, D, L, or C as H 
changes over a range of values, use the Excel Fill 
Handle to copy the function formula down into the 
associated cells. 

(To activate the Fill Handle, move the mouse to 
the lower right corner of the active cell. The 
mouse changes to a black plus sign. 

If the Fill Handle does not appear, select 
Tools|Options|Edit and tick the Allow cell drag 
and drop check box.) 

 
Use Excel’s Fill Handle to copy the formula down 

Press the Calculate button to recalculate the 
worksheet. (The Si8000 Workbook sets Excel’s 
Calculation mode to Manual; see 
Tools|Options|Calculation). 
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The Si8000 field solves for the selected 
characteristic in all associated rows . 

 

The embedded chart is refreshed with the results 
of the calculation. 

 

Plot of Z0 as Height (H1) varies 
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Choosing other parameters 
Z0, D, L and C can be plotted against any of the 
function parameters. 

For example, to display Z0 as Er1 varies, in the 
example reset H1 to a single value, e.g. 8, and 
plot Z0 against changes of Er1 between 3.8 and 
4.35 in 0.05 increments. 

Changing the parameters 

Select the first value in the Height column and 
use the Fill Handle to fill down to row 16 with the 
value 8. 

Change the first value in the Er column to 3.8, 
change the second value to 3.85 then select both 
cells. 

Use the Fill Handle to fill down to row 16; Excel 
detects the two cell values as an incrementing 
sequence and fills the column accordingly with 
values increasing at 0.05 intervals. 

Click the Calculate icon to refresh the Z0 column. 

 

Z0 against Er1 with other parameters fixed 
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Modifying the chart 

It will be necessary to modify the chart to reflect 
the new scales and Category axis. 

Right click the chart area and choose Source 
Data… 

 

From the Source Data dialog box, click the Series 
tab; the Series page shows the source data cell 
ranges for the chart. 

 

Click the Collapse Dialog button, (  ), in the 
Category (X) axis labels: edit box and select the 
range of Er values charted. 

Click the button again to restore the dialog box 
and press OK. 
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Click the Category Axis Title label and replace the 
H with Er. 

Right click the value axis and choose Format 
Axis… 

Choose the Scale tab and change the values as 
necessary for Minimum and Maximum scale 
values.  

 

Press OK. The chart should appear as shown 
below. 

 

Format the chart (color, scales, etc.) as required. 

Repeat the procedure for other parameter values. 
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Using the Si8000 functions in other workbooks 
The Si8000 functions supplied by the Si8000 
workbooks, Si8000.xls or Si8000Expert.xls, are 
available for use in other workbooks. 

Prior to using any of the Si8000 functions it will be 
necessary to ensure the Si8000.xls workbook or 
Si8000Expert.xls is open. In this discussion the 
worksheet is assumed to refer to the Si8000.xls 
workbook. 

The Si8000 functions use the board parameters, 
H1, W1, Er1 etc. as arguments. Parameter values 
can be derived from existing data in worksheet 
cells or inserted into the Formula Palette directly. 

Begin a new worksheet. 

In the example below the values for a Surface 
Microstrip structure are contained in cells B4 to 
G4. We insert the Si8000 Surface Microstrip 
function into cell H4. 

 

To use a function, from the Insert menu choose 
Function… or click the Insert Function button 

 on the tool bar. The Paste Function dialog 
box is displayed. Choose the User Defined 
category to display the user-defined functions. 
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Scroll to the Si8000 functions; click the function 
associated with the surface microstrip structure 
(Si8000.xls!SurfaceMicrostrip1B in this example) 
and click OK: the Formula Palette is displayed. 

Using the Formula Palette to enter formulas 

Use the Excel Formula Palette to enter function 
parameters. The Formula Palette creates an edit 
box for each argument in the function. 

 

Click the Collapse Dialog button (  ) in the H1 
edit box and select cell B4: click the button again. 
Tab through the other edit boxes and repeat the 
procedure for each value. 
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As the function is entered, the Formula Palette 
displays the value of each of its arguments, the 
current result of the function, and the current 
result of the entire formula. When the last value is 
entered Excel calculates and displays the final 
result. 

 

Press OK to close the Formula Palette and 
complete the formula. 

 

Z0 calculated for a single set of values 

To calculate Z0 over a range of parameter values, 
select the data and formula (cells B4 to H4) and 
use the Fill Handle to copy down as necessary. 

Select each column of cells as appropriate and 
enter the new parameter values. 

Hint: to fill a range of cells with a single value 
select the range, type the value and press Shift + 
Enter. 

Press Shift + F9 to recalculate the sheet. 
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If necessary use the Increase decimal/Decrease 
Decimal buttons  to select the required 
number of decimal places. 

Format as required. 

 

Z0 calculated for changing Er 

Charting results 
Use the Excel Chart Wizard to chart the results. 

Select the area to be charted: in this example the 
Er1 and Z0 ranges (to select non-adjacent ranges, 
press Ctrl while dragging the mouse over each 
range). 

 

Click the Chart Wizard button  to start the 
Chart Wizard. 
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From Step 1, Chart Type, of the Chart Wizard, 
choose Chart Type: XY (Scatter) type and Chart 
sub-type: Data points connected by lines 

 

Click Next to select Step 2, Chart Source Data. 

 
Check the Data Range: in this case the cell 
references are correct. 

Leave the Series in: option set to Columns. 
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Click Next to select Step 3, Chart Options, and 
add titles for the chart and its axes and 
(optionally) remove the legend. 

 

Click Next to select Step 4, Chart Location. 

 

Use the Chart Location  dialog box to choose where 
Excel creates the chart. 

To place the chart on a new chart sheet, click 
As new sheet:, and type a name for the new 
chart sheet. 
 

44  •  Si8000 Controlled Impedance Field Solver  



To embed the chart on the worksheet, click 
As object in:, select a sheet name from the 
As object in: list box, and click Finish. 

 

Choose the As object in: option then drag 
and size the embedded chart as required on 
the worksheet. 
 
To modify the data series (e.g. line weight, 
marker style etc.) right click the chart line and 
choose Format Data Series… 

 

Change the series format as required. 
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Using the Si8000 to plot multiple data series 

Plotting Z0 for surface and coated microstrip 
Inserting the first data series 

Supply the data and plot the data series for 
Surface Microstrip as described earlier. 

 
In this example, plot Z0 against Er. 

To add comments, titles, etc., to the chart, click 
into the Excel Formula Bar, type the text and 
press <Return>; the text appears on the chart —
place the text as required. 
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To format any chart item, right click the item and 
change its properties via the short cut menu. 

Adding the second data series 

Supply the data for the Coated Microstrip 
structure as shown below. 

 

Right click the chart and choose Source Data… 
from the menu. Click the Series tab. 

 

Click the Add button to add a second series to 
the chart; in this case we use the same values for 
the X axis. Click the Collapse Dialog button and 
select the values in the Er1 column. 
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Repeat for the Y axis; select the values in the 
Coated Microstrip Z0 column. 

 

Add the name Coated Microstrip to the Name text 
box, click the Z0 series from the Series list and 
add the name Surface Microstrip; press OK. 
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Right click the Y axis and choose Format Axis…, 
choose the Scale tab and specify a suitable value 
(in this case 67) as the minimum value. The chart 
should appear as below. 

 

Use the Formula Bar to add explanatory text as 
necessary (in this case the titles Surface Microstrip 
and Coated Microstrip were added to the chart). 
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Plotting Zeven and Zodd v trace separation 
In this example we use the Edge Coupled Offset 
Stripline structure to examine the effects of 
decreasing trace separation on even and odd 
impedance. 

Choose the Edge Coupled Offset Stripline 
structure from the Si8000 main index sheet. 

Supply the values for H1 (copy the value 8 to all 
cells in the height column). 

Supply the decreasing values for S (7.75 to 0.25 
in 0.5 steps). 

Change the Calc Type to Zeven. 

Change the Formula column heading to Zeven. 

Fill down the formula column with the function. 

Press the Calculate button to display the results 
— partial results are shown below. 

 
Insert a column to the right of the formula column. 

Select the formula cells, choose Copy and select 
the cell to the right of the Zeven label. 
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From the Edit menu choose Paste Special…  

 
Choose the Values option and press OK. 

Press Esc to exit Copy-Paste mode. 

Change the Calc Type and the label of the 
formula column to Zodd. 

Press the Calculate button. Partial results are 
shown below. 
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The associated chart should show the results for 
Zodd. 

Drag the column of Zeven values onto the chart. 

Modify the chart so the Source Data Category (X) 
axis labels, and Series refer to the S1, Zeven and 
Zodd cell ranges. 

Choose a suitable minimum value for the Value 
(Y) axis. 

Format the axes and add text labels as required. 

The results are shown below. 
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Using more complex models 

Calculating the effect of etch back 
In this example we consider the effect of PCB 
trace side-wall slope. As part of the process we 
chart the change in impedance due to variations 
in dielectric thickness and trace width. We use the 
surface microstrip structure. 

Begin by entering the parameter values for the 
surface microstrip structure in cells A2:F2. 

 

The etch back factor will be a variable so assign 
W1 a value of 7.00, locate the etch back factor in 
cell D7 and define W as C2–D7 (i.e. W1 minus 
etch back factor). Assign a value of 0.3 as etch 
back factor and insert the Surface Microstrip 
function into cell F6: 

=Si8000.xls!SurfaceMicrostrip(A2,B2,C2,D2,E2,F2) 

Press Shift-F9 to calculate. 

Calculating the effect of variations in Height 
Next, chart the effect of varying height H1 in 0.05 
steps. Create references to cells A2–F7 in cells 
A22–F22, add the surface microstrip function to 
G22 and change references B22–F22 to mixed as 
shown below (click into the formula and use the 
F4 key to change each reference). 

= Si8000.xls!SurfaceMicrostrip1B(A22,B$22,C$22,D$22,E$22,F$22) 
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Copy the formula in G22 up to cell G17 and down 
to G27 as shown above 

Create a step value of 0.05 in D14, enter the 
equation =A22+$D$14 in cell A21 and fill it up to 
A17. 

Enter the equation =A22-$D$14 in cell A23 and fill 
it down to A27. 

Use the Auditing Toolbar Trace Precedent and 
Dependent arrows to check references are as 
shown above. Press Shift-F9 to recalculate. 

Select ranges H1(var) A17:A27 and Z0(H1) 
G17:G27 and chart; the chart should appear as 
below. 
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Charting trace width error 
Next we chart the effect of varying the trace width 
with a fixed trace side slope 

 

Create references to A2:F2 in cells A41:F41. 

Enter the formula 
=Si8000.xls!SurfaceMicrostrip(A$41,B41,C41,D$41,E$41,F$41) 

in cell G41 and copy it up to G36 and down to 
G46 as shown. (Note that B41 and C41 are left as 
relative references.) 

Create a step value of 0.10 in cell D33. 

Enter formula =D41-$D$33 in cell C40 and fill up to 
C36. 

Enter formula =C40-$D$7 in cell B40 and fill up to 
B36. 

Enter formula =C42-$D$7 in cell B42 and fill down 
to B46. 

Enter formula =C41+$D$33 in cell C42 and fill 
down to C46. 

Use the auditing arrows to check cell precedents 
and dependencies. 

Recalculate. 
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Select ranges C36:C46 and G36:G46 and chart. 

The trace width error chart should appear as 
shown below. 

 

Charting etch back error 
Finally, we chart the effect of etch back error. 

 
Create references to cells A2:F2 in cells A61:F61. 

Enter the function 
=Si8000.xls!POLARSURFACEMICROSTRIP(A$61,B61,C$61,D$61,E$61,F$61) 
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in cell G61. (Note the relative reference to cell 
B61.) Fill up to G56 and down to G66. 

Create a step value of 0.10 in cell D53 

Enter the formula =B61-$D$53 in cell B60 and fill 
up to B56. 

Enter the formula =B61+$D$53 in cell B62 and fill 
down to B56. 

Audit the precedents and dependencies. 

Select cell ranges W(var) B56:B66 and Z0(W1) 
G56:G66 and chart. 

The chart for an etch back error of 0.25 appears 
below. 

 

Change the etch back factor cell value in cell D7 
and recalculate to observe the change in 
impedance of a different trace side slope. 

Si8000 Controlled Impedance Field Solver  •  57 



 

58  •  Si8000 Controlled Impedance Field Solver  

Appendix 

For further relevant papers and application notes 
visit the Polar Instruments web site, 
www.polarinstruments.com. 
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Terms used in this manual 
AC Alternating Current 

CMOS Complimentary Metal Oxide Silicon 

DC Direct Current 

ECL Emitter Coupled Logic 

EMI Electromagnetic Interference 

FR-4 Epoxy Glass Dielectric Material 

TDR Time domain Reflectometry 

TTL Transistor-Transistor Logic 

Zo Characteristic Line Impedance 

Zo' Characteristic Line Impedance (Loaded) 

Er Relative Permittivity (homogeneous dielectric 
materials) 

E'r Effective Relative Permittivity (non-homogeneous 
dielectric materials) 
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